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Descripción. 
 
En la siguiente práctica se realizará el modelo CAD de un SOPORTE, donde se utilizarán 
funciones básicas de UGS-NX6 para el modelado de piezas. Se utilizarán diferentes opciones 
para la creación de un plano de trabajo llamdo Sketch; se explicarán los principales íconos para 
realizar una geometría dentro de un Sketch y se utilizarán funciones como Hole (para hacer 
orificios), Extrude (para extruir una geometría o en su defecto para substraer material no 
deseado de un sólido), Revolve (para hacer cuerpos de revolución) y Edge Blend (se utiliza para 
hacer bordes en las esquinas de un sólido).  
 
Objetivo. 
 
Mostrar al usuario el uso de las funciones básicas de Modeling en UGS-NX6, para realizar un 
modelo CAD. 
 
 
Desarrollo. 
 
1. Abrir un nuevo documento.  

<File> <Open...>   
Nombre del archivo: Biela 
[OK] 
 

Para iniciar el dibujo se selecciona un plano de trabajo llamado Sketch  
2. Creación de un Sketch de trabajo. 
 
Para seleccionar un Sketch podemos  hacerlo de tres formas diferentes:  
 

• Selecciona Insert  Sketch. 

• Selecciona el icono   . 
• Selecciona la tecla “S”. 

 
Aparece la ventana Create Sketch, en el área gráfica  selecciona el plano Y-Z. 
 
Selecciona [OK] 

Selecciona el ícono  . Una vez seleccionado, se requiere dar la ubicación del punto 
de inicio, posteriormente se dará la longitud y dirección de las líneas. La ubicación de dicho 
punto es X=0, Y=76.20. Las longitudes y direcciones de las líneas son las siguientes: 

Número de línea Longitud 
[mm] 

Angulo 
[°] 
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1 139.7 0 
2 76.20 270 
3 15.88 180 
4 107.43 145.84 
5 34.92 180 
6 15.88 90 

 
El resultado se muestra en la figura 1: 
 

 
Figura 1. Sketch de trabajo. 

 

Salir del Sketch con el ícono . 
 
3. Creación de una Extrusión. 

Selecciona el ícono  o teclea la letra “X” y aparecerá la ventana de la figura 2, 
asignando los parámetros que en ella se indican:  
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Figura 2. Ventana de datos de Extrude. 

 
Selecciona [OK] 
 
Lo que se obtiene se muestra en la figura 3: 
 

 
Figura 3. Extrusión 

 
4. Creación de un Sketch de trabajo sobre una cara. 
 

Selecciona el ícono ,  
Selecciona Create Plane  a continuación especifica la dirección Y, para generar un plano 
paralelo al plano XY a una distancia de 139.7mm, como se indica en la siguiente figura 4: 
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Figura 4. Creación de un plano 

 
El plano de trabajo ahora se encuentra en una esquina de la pieza, (Fig5) 
 

  
Figura 5. Cara donde se sitúa el sketch de trabajo. 

 
Selecciona [OK] 
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Dentro del sketch generado, se dibujará hará la geometría mostrada en la siguiente figura 5. 

Para ello, se requiere seleccionar el ícono , y el punto de inicio se ubica en X=12.7, 
Z=0. Las longitudes y direcciones de las líneas se muestran en la siguiente tabla: 
 

Número de línea Longitud 
[mm] 

Angulo 
[°] 

1 60.32 90 
2 63.5 0 
3 60.32 270 
4 63.5 180 

 

 
Figura 5. Geometría a dibujar. 

 

Para salir del Sketch selecciona el ícono . 
 
5. Creación de una Extrusión para extraer material. 

Selecciona el ícono  y aparecerá la ventana de la figura 6: 
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Figura 6. Ventana de datos del comando Extrude. 

 
Selecciona la geometría asociada al anterior Sketch de trabajo y asigna los siguientes 
parámetros. 
Star distance = 15.88 mm. 
End distance = 104.78 mm. 
Boolean: Subtrack. 
 
Selecciona [OK] 
 
El resultado de la anterior secuencia se muestra en la figura 7: 
 

 
Figura 7. Subtract. 

 
6. Creación de un orificio con Hole. 
 

Selecciona  el ícono , aparece la ventana Hole (Fig. 8). 
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Figura 8. Ventana de datos del comando Hole. 

 
Selecciona la cara que se indica en la figura 9. 
 

 
Figura 9. Selección de cara. 

 
El sistema creará un plano de trabajo (Sketch) en de dicha cara, ahora es posible introducir 
las coordenadas del centro del agujero (Fig. 10). 
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Figura 10. Ventana de datos para posesionar el hole. 

Selecciona [OK], [OK], 
Finish Sketch 
Selecciona [OK]. 
 
Con la que se obtiene la figura 10. 

 
Figura 10. Hole 

Selecciona [Apply]  
 

A continuación se realizará el procedimiento anterior para la creación de un Hole del lado 
derecho, sobre la misma cara. Las coordenadas son las siguientes (Fig. 11): 
 

 
Figura 11. Coordenadas del segundo Hole. 

 
Para obtener la figura 12. 
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Figura 12. Hole. 

 
7. Creación de un nuevo plano de trabajo. 
 
Selecciona el ícono Sketch y aparecerá la ventana de la figura 13. Se creará un plano de 
trabajo con la opción punto y dirección 
 
Selecciona en Plane Option> Create Plane como se indica a continuación (Fig. 13). 
 

 
Figura 13. Ventana de selección de Sketch. 

 
Selecciona el punto de la pieza como se indica en la figura 14: 

 
Figura 14. Selección del punto. 
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Aparecerá el plano de trabajo, indica la dirección como se muestra en la figura 5. 
 

 
Figura 15. Plano. 

 
Selecciona la cara del sólido que se muestra en color rosa (Fig. 16). 
 

 
Figura 16. Cara de cuerpo. 

 
Selecciona [OK] 

Selecciona el ícono  y el primer punto será el “A” como se indica en la figura 17. 
Las longitudes y direcciones de las líneas restantes se describen en la tabla siguiente: 
 

Número de 
línea 

Longitud 
[mm] 

Angulo 
[°] 

1 25.52       270 
2 142.01      10.35 
3 139.7       180 
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Figura 17. Ubicación del punto A y creación del sketch 

 
Selecciona Finish Sketch. 
 
8. Creación de una Extrusión. 
 

Selecciona  y la geometría del último Sketch (Fig.18). 

 
Figura 18. Selección de geometría. 

 
Asignar los parámetros como se muestra en la siguiente ventana de la figura 19: 

 
Figura 19. Ventana de parámetros de extrusión. 
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Selecciona [OK] 
 
9. Ocultar Sketch de trabajo. 
 
A continuación, selecciona los Sketches con los que hasta el momento has trabajado, como 
se indica en la figura 20. Existen dos formas de ocultar los Sketches: 
 

• Selecciona los Sketches  y con botón derecho del Mouse selecciona Hide. 

• Selecciona directamente, en la barra de menú el icono , selecciona los planos y 
OK. 

 

 
Figura 20. Hide. 

 
10. Insertar una línea en el espacio. 
 
La función de la línea será actuar como directriz de un cuerpo de revolución. 
Selecciona en la barra de menú: Insert >Curve >Line. 
 
Selecciona el origen de la línea, como se indica en la siguiente figura 21. No es importante 
la longitud de la línea, asígnale una longitud de 50 en la dirección “Z” (Fig. 22). 

 
Figura 21. Ubicación de una línea en el espacio. 
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Figura 22. Dirección de la línea en el espacio. 

 
Selecciona [OK] 
 
Obteniendo como resultado lo que se muestra en la figura 23. 
 

 
Figura 23. Línea en el espacio. 

 
11. Generar un Sketch auxiliar para la construcción de la generatriz del elemento de 
revolución. 
 
Selecciona Sketch> Create> Plane en “X” Referencia horizontal. 



 
 
 
 
 
 

15 
 

FACULTAD DE INGENIERIA 
LIMAC 

UNIGRAPHICS NX6 

 
Figura 24. Ventana de selección de Sketch. 

 
La distancia en X debe ser de 44.45 [mm] y como referencia selecciona la línea de color 
rojo (Fig. 25). 

 

 
Figura 25. Referencia del Sketch 

Selecciona [OK] 
 
Ahora se dibujará una línea. 
Selecciona el ícono de Profile, ubicando el punto inicial en: X=104.78, Y=44.45. Las 
longitudes y direcciones  son las siguientes: 
 

Número de línea Longitud [mm] Angulo [°] 
1 44.5 180 
2 17.08 210 
3 29.6 180 
4 9.525 270 
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5 29.6 0 
6 17.08 30 
7 40.27 0 
8 8.63 60.69 
9 2 90 

 
La figura 26 muestra el perfil a obtener. 

 
Figura 26. Sketch de la generatriz del elemento de revolución. 

 
Selecciona Finish Sketch 
 

Selecciona el ícono Revolve  y aparece la ventana de la figura 27.  
 

 
Figura 27. Ventana de parámetros del comando Revolve. 

 
Selecciona la curva de la generatriz en color azul, como se indica en la figura 28.A. Para 
especificar el vector Specify Vector, selecciona la línea de la figura 28.B. 
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Figura 28. A. Selección de la generatriz.  

B .Selección del vector. 
 
Selecciona [OK] 
 
Finalmente se obtiene (Fig. 29). 
 

 
Figura 29. Elemento de revolución. 

 
12. Unir las piezas. 

Selecciona el ícono  y a continuación las piezas que se han modelado, una a una, 
hasta formar un sólo sólido (Fig. 30). 
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Figura 30. Unión de sólidos. 

 
13. Creación de un nuevo Sketch de trabajo. 

 
Selecciona Sketch y la cara donde será ubicado (Fig. 31): 

 

 
Figura 31. Ubicación de nuevo sketch. 

Selecciona [OK] 
 

Selecciona Arc , selecciona el centro y los puntos extremos y se dibujará un sector 
circular, como se indica el siguiente figura 31, cierra el área con una línea. 
 

 
Figura 31.Sector circular. 
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Salir del Sketch. 
 

Selecciona , aparece la ventana de Extrude y asigna los datos que se muestran en 
la figura 32. Selecciona el sector circular anterior: 
 

 
Figura 32. Ventana de parámetros de extrusión. 

 
Selecciona [OK], verifica que el resultado que se obtienes es el mismo que el sólido que se 
muestra en la figura 33. 

 
Figura 33. Sólido 

 
14. Creación de Sketch de trabajo. 
 
Selecciona Sketch >Create Plane ”Z”. 
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La distancia sobre el eje Z debe ser de 69.9 [mm] y la referencia es el eje “X”: 
 

 
Figura 34. Plano de trabajo a 69.9m y referencia el eje “X”. 

 

Selecciona el ícono  y se generan dos círculos concéntricos de 11.11[mm] y 19.05 
[mm] de diámetro (Fig. 35), además, se trazarán dos líneas perpendiculares como se indica 
a continuación: 

 
Figura 35. Círculos concéntricos y líneas auxiliares. 

 

Selecciona el ícono  Rectangle, como primer punto selecciona el centro del círculo, 
posteriormente selecciona uno de los extremos (Fig. 36) y con esto defines la base del 
rectángulo.  
 

 
Figura 36. Creación de un rectángulo con tres puntos. 

 
Teclea la altura de 6.35[mm] del rectángulo como se indica en la figura 37. 
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Figura 37. Altura del rectángulo. 

 
Realiza el mismo proceso para crear un rectángulo en la dirección vertical, obteniendo los 
elementos de la figura 38. 
 

 
Figura 38. Creación de un rectángulo sobre la línea vertical. 

Con el ícono  se cortan las líneas auxiliares (Fig. 39): 
 

 
Figura 39. Sketch terminado. 

Selecciona Finish Sketch. 
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Selecciona  y la geometría del Sketch que se trabajó anteriormente, asignándole 
una altura de 19.05 [mm]. 
 
Selecciona [OK] 
 
15. Creación de Sketch de trabajo. 
 
Realiza un nuevo Sketch y selecciona la cara que se muestra en la figura 40. 

 
Figura 40. Selecciona de la cara para un nuevo sketch. 

 
Traza dos círculos concéntricos de 11.11[mm] y 19.05[mm], como se muestra en la figura 
41. 
 

 
Figura 41. Creación de dos círculos concéntricos. 

Selecciona Finish Sketch 
 

Selecciona   y asigna los siguientes parámetros: 
 
Start Distance = -3.18 [mm] 
End Distance =3 [mm] 

 
Selecciona [OK] 
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Se obtiene lo siguiente (Fig. 42): 
 

 
Figura 42. Creación de la extrusión. 

 
16. Unir las piezas. 
 

Selecciona el ícono  y forma un nuevo sólido con los cuerpos generados durante 
el proceso (Fig. 43). 
 

 
Figura 43. Unión de sólidos. 

 
Selecciona Sketch >Create Plane> en la dirección”Z”. 
La distancia debe ser de 88.9 [mm] 
 
Sobre el Sketch, realiza dos círculos concéntricos, uno de 88.9 [mm] y el otro de 107.95 
[mm], como se indica en la figura 44. Traza tres líneas que partan del centro de los círculos 

con un ángulo de 120[°] una de otra, para parametrizar el ángulo, selecciona  y 

aparecerá una ventana donde seleccionarás . 
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Figura 44. Creación de dos círculos concéntricos y líneas a 120°. 

 
En la intersección de las líneas con el círculo mayor, traza dos círculos de 9.52 [mm] y 
19.04 [mm], como se indica en la figura 45. 
 

 
Figura 45. Creación de círculos concéntricos. 

Con el ícono   borra las líneas auxiliares que no sirven, como se indica en la 
figura 45: 

 
Figura 46. Borrar líneas auxiliares. 
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17. Creación de un filete. 

Selecciona el ícono  y los arcos A y B como se indica a continuación (Fig. 47). 

 
Figura 47. Selección de los arcos A y B. 

 
Asigna un radio de 20 [mm]. 
 

Con el ícono  recorta las líneas auxiliares como se indica a continuación (Fig. 
48): 
 

 
Figura 48. Sketch terminado. 

 
Finalizar sketch. 
 
18. Creación de una Extrusión. 
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Selecciona  y la geometría referente al Sketch anterior, con los parámetros que 
siguientes: 
 
Start Distance = 0 [mm] 
End Distance = 12.7 [mm] 
 
19. Creación de un borde. 

Selecciona el ícono  y selecciona el contorno de las pestañas, como se indica a 
continuación en la figura 48. 

 
Figura 48. Selección de la línea donde se generará el borde. 

 
Asigna un radio de 1[mm], realiza la misma operación a todas las pestañas del soporte. 
 
20. Finalmente el modelo sólido del soporte. 

 


